
Technology Integration @ LMS

This has nothing to do with Technology other 
than the fact that I first learned about this on the 
Internet. Recently, I read this same information in 
the latest issue of “Technology and Learning.” So, 
it must be true! Krispy Kreme Doughnuts is re-
warding students with a free doughnut for each A 
that they earn on their report cards. This offer is 
good for up to six doughnuts during a single grad-
ing period.

Seriously, I doubt that eating six doughnuts is 
going to make a big difference in anyone's weight; 
however, turning such a reward into a lifelong 
habit definitely will. Rewarding students with 
doughnuts is an interesting approach to take for 
any business considering the push by school sys-
tems across the country that are promoting 
healthy lifestyles.
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I really do hope that there are teachers out there 
that look forward to my monthly newsletter. 
Those of you that do look forward to my monthly 
news, tips, and tricks probably noticed that “Point 
- Click - File & Save” didn’t arrive in your mail-
box on time this month. Please accept my sincere 
apologies. Other duties around school and at home 
have taken up a great deal of my time. Those 
things happen. Better late than never!

Hmmm, wasn’t that last sentence an English id-
iom? Yes it is and you can learn more about idioms 
at www.goenglish.com where you can find a new 
idiom every day. Why? Because variety is the 
spice of life. Should anyone ask you where you 
learned about www.goenglish.com, just say word 
of mouth. Okay, I have to shake a leg and move 
on!

 I’ll Give You a Doughnut for an ASorry, Sorry, Sorry!

Whatever happened to learning 
as its own reward?

A =
Should you want to read more about this go to: 

http://www.newstarget.com/002630.html
Also check out: 

http://www.commercialalert.org/index.php/external
/true/article_id/266

On a positive note, while I did research on this 
subject, I also learned what other schools are serv-
ing their students on a regular basis. I encourage 
you to do a similar search. I believe that you will 
find that our school lunch program is making real 
strides in providing healthy options for our stu-
dents.

An excellent open-ended writing 
prompt for students!

Over vacation, I ran into Kay Allison in the 
LMS lobby. Actually she chased me down to say 
that she is having success with her web page. Kay 
is putting together a really nice web page to show-
case her students' work. Kay is doing all of the 
coding in HTML herself and she was very excited 
to tell me that she was able to solve a code prob-
lem all by herself. She’s excited about her web site 
and is obviously having fun with the design. Once 
she goes “live” you will be able to see it at 
http://www.lewiston.k12.me.us/~kallison

We will be seeing some really great things on 
this web site. Once she has her site exactly as she 
wants it, I will remind you to take the time to 
visit.

Kay--You Made My Day!

~kallison
Don’t forget the tilde. Hold down the 
shift and click on the key to the left of the 
number 1 key.

http://www.goenglish.com/
http://www.goenglish.com/
http://www.lewiston.k12.me.us/~kallison/
http://www.newstarget.com/002630.html
http://www.commercialalert.org/index.php/external/true/article_id/266


Technology Integration @ LMS February/March 2005Page 2

find that our school lunch program is making real 

www.portaportal.com
Enter through the 

guest access: 
demons

I’ve Added More Stuff!
Check it Out.

Tech Clinics
Last Chance

For 
Beginner

NoteTaker
Sign up in the Teachers Room

Last Chance Until Next Year

Sick Teacher
(Before)

Happy Teacher
(After)

Let Your Computer Help You Plan for 
Those Days When You Can’t be in School

• Use the drawing module of AppleWorks  to draw your seating 
charts. Keep your charts current and in the formation of your 
room. Include the first and last names of the students.

• Use NoteTaker to make a web site that students can go to on days 
that you aren’t in school. In this online notebook, explain what 
you want the students to do. Include worksheets that can be 
printed out for students to handwrite on or link to an AppleWorks  
download so that answers can be typed.

• Instead of asking a fellow teacher to pick up your material for the 
sub, send it via e-mail to your buddy teacher.

• Create a mailing list of your students so that you can e-mail them 
with your expectations for the day.

• If you are not too sick, allow students to e-mail you with ques-
tions. Use your MiddleMaine account so that you won’t be 
bugged with questions over LewNet.

• Create a unit especially for a sick day. Keep it on your computer
so you can easily find it, print it, and have it ready for photo-
copying.

Leave seating charts, absent report pads, emergency 
evacuation forms, class lists, and the smile/sad face poster 
in a place that a sub can easily find.
Make sure that you have plans for the day and that any 
special equipment is working and ready to go.
Remember, the sub is doing you and the students a favor. 
Don’t ask them to do your paperwork. We want them to 
return and sub again.
If a student gives a sub a hard time, make sure that you 
deal with it properly upon your return.

http://www.portaportal.com/
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NoteTaker is a great program; however, this application is a work in progress. You may often run into 
problems using this program. Operations that look pretty straightforward in the manual sometimes don't 
work. Aquaminds needs your help and asks that you report problems to their design staff. They do 
listen and fix any problems in a timely fashion. To report a problem, go to www.aquaminds.com and click 
on the Support link. Make sure you are very specific about what happened so that they can recreate the 
problem.

Aquaminds is also willing to listen to any suggestions you have that might make NoteTaker 
even better. Got any ideas? Write to them. They will write back--usually within 24 hours!

Aquaminds Needs Your Help

A Few Notes About NoteTaker
   Are you a preferences junky? If you are, Notetaker has something 
especially for you. NoteTaker provides users with a 7-tabbed Pref-
erences window. These preferences will allow you to customize 
how NoteTaker works for you. To get to the Preferences window, 
simply go to the NoteTaker menu and click on Preferences. In the 
window that opens, you will find tabs that will give you options for
various parts of the program. The tabs are: General, Window, Entries, 
Format, Keys, Drawer, and Toolbar.

   A very basic but useful modification is 
found under the General tab. I have un-
checked the “Show splash screen” and 
“Create new notebook” checkboxes. The 
splash screen is only an advertisement and 
“Create new notebook” isn’t really neces-
sary especially when I just want to open a 
notebook that I have used before.

   Under the Backup Section, you will no-
tice that I have Autosave on for every 5 
minutes. I use this only as a safeguard. I 
still save my work regularly using the 
Command and S keys. By the way, the 
Command key is the one with the apple 
on it. Why they don’t just call it the 
Apple key is beyond me!

One Small Word of Caution: If and when the student image includes NoteTaker, you might find that the 
students preferences may be different than yours. At least with AppleWorks , a good majority of students 
don’t bother with making adjustments. When teaching NoteTaker to your students, remember to set your 
preferences to the default settings as your preference changes may confuse students that are expecting their 
program to work exactly like yours.

I find that unchecking these two 
boxes is helpful.

http://www.aquaminds.com/


Technology Integration @ LMS February/March 2005Page 4

Leave Some Trees for the Beavers!
   Bucky Beaver, President of the Busy Beavers Local 504, has contacted me 
with concerns about students printing everything under the sun. Not only 
does unnecessary printing take business way from the beavers but it is 
costly to the school system. Please remind your students to print wisely.

   Bucky was really angry at David and me for introducing NoteTaker. He wants us to stress that 
when you print with NoteTaker, you need to keep in mind that going to the File menu and selecting 
Print will cause the program to print the whole notebook. This could be a considerable number of 
pages, depending on the size of the notebook. Please make sure that if you don’t need to print the 
whole notebook but only one page, go to the File menu and click on Print Page. Should NoteTaker
become part of the student image next year, please make sure that you pass this on to the students.

Tabs Left, Tabs Right, No Tabs at All
   In NoteTaker Preferences, under the Window tab, you can change the orientation of your tabs. This can 
only be done with a New Notebook. Simply click on the appropriate “radio” button in Preferences before 
you begin your notebook. You can use either Bottom, Right, or Hidden. Quit out of NoteTaker and then 
boot it up again. The change will take place.

Programmers call the little cir-
cles “radio buttons” as they 
look like the radio buttons on an 
old car. You simply click on the 
one you want. If you decide you 
want to change, click on another 
radio button. What about the 
square ones? Those are called 
checkboxes.

   Oh! What a site! Did you catch that? "Site" should have been "sight." I do that all of the time. I know better, 
but my fingers sometimes type the wrong word. In Notetaker, there is a Find and Replace With utility. Just 
click on the magnifying glass found in the drawer. When the utility appears, it asks for the word you want to 
search for, and then gives you the option of replacing it with another word. You are able to select the scope of 
the search by selecting Notebook, Section, or Page. It works great. Give it a try!

Find and Replace

Click here to use Find and Replace.
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Hooke’s Law
If a vertically mounted rod, wire, or spring is supported rigidly at its upper end 
and weights are added to its lower end, the amount by which it is stretched is 
found to be directly proportional to the weight applied. This is known as 
Hooke’s Law.

I remember this experiment from high school physics. It’s an easy enough con-
cept, but how do we show or prove Hooke’s Law to our students? If you had 
DataStudio on your MLTI Apple iBook, you could show this graphically. Guess 
what? You and your students do have DataStudio and, thus, everyone has within 
their computer a graphing calculator.

In your Applications folder, look for this icon. 
Place it on your dock for easy access. Click on it 
to start up DataStudio.

You don’t need probes to use DataStudio. By clicking on 
this icon you can easily enter your data.

Now enter your data. I used the X axis to repre-
sent pounds. The Y axis represents length in 
inches. See how I entered my data. As I entered 
the data, my graph automatically represented 
my findings with a linear line.

My Data My Graph
(Please Note: My graph probably doesn’t show up as clearly as it did on my computer. I lose a lot 
of detail when I photocopy these newsletters. Feel free to check out this newsletter in all of it’s 
colorful glory on the school department’s web site.)

Plenty of great opportunities for 
Math and Science teachers hidden within DataStudio.

http://www.lewiston.k12.me.us/~resfored/learning/mlti.htm
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Free Timer - Yours for the taking!

If you often have timed tasks for your students, the Chimoo Timer  may be of interest. You can have it 
play a simple beep or speak a message once time is up. I have demonstrated this timer during my tech- 
nology clinics. If you would like a copy of this program, simply go to http://www.versiontracker.com 
and enter a search for Chimoo Timer . If you time student tasks, I'm sure you will be happy with this 
timer.

Thank You
Teachers

For Supporting the 
X-treme Typing Challenge @ LMS

Please don’t stop challenging students to improve their typing 
skills. You may be surprised at just how much students are get-
ting from practicing with UltraKey and then participating in our 
program. This past Christmas, I was shopping at Penney’s and 
was chased down by a former student. She wanted to tell me that 
she continued working on her typing skills at LHS and that now 
she types accurately and with speed. A satisfied customer! We 
sometimes don’t realize just how much our efforts have meant to 
our students. She thanked me and now I’m passing that thanks 
on to you. We, the LMS staff, made a difference together.

Do you mean, how did I add the writing to the chalkboard? 
If so, it was easy. I made a text frame using the Text Tool. 
Remember, since I’m in word processing, I had to hold 
down on the option key while I clicked and dragged.

Text Tool

I then wrote my message, changed the text color to white, 
and then dragged it onto the chalkboard. I found the teacher 
with the chalkboard in Clippings.

Okay, how did you do that?

Wish this
was a

SmartBoard Wish this
was a

SmartBoard
You know you’re getting old when the newly 
hired teacher in the next room asks “What’s a 
chalkboard?”

http://www.versiontracker.com/
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